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EP Evaluator® Release 11

A brand of Data Innovations®

Release 11.3 (January 2016)

The new version EP Evaluator has been extensively enhanced and tested based on customer feedback and the latest regulatory
requirements. Here's what's new in EP Evaluator 11.3.

Product Area Enhancements in release 11.3

CLSI EP26 compatibility (2IC)

This release includes a new reagent lot variation evaluator as an extension of the two instrument comparison (2IC) statistical
module. A new EP26 lot-to-lot variation tab can be accessed through the 2IC parameters screen. This feature makes release 11.3
compliant with the CLSI EP26 document. This statistical module in EP26 mode compares data from different reagent lots
rather than data from different instruments. Experiment reports can be assembled and printed using the new mode. In EP26
mode, EE can use tables from the Appendices of the CLSI EP26-A standard (September 2013) to determine the number of
samples required and the percent rejection criteria. (EEC1119)

Linearity and Calibration Verification (LIN)

A warning message is now displayed at the bottom of the Parameters screen if the user first selects a Report Option checkbox,
then either leaves blank or enters zero as the Allowable Total Error (TEa) in the Concentration value for the reports, while also
having a zero value for the lowest assigned specimen concentration value. The experiment will always fail in this case.
(EEC1131)

Complex Precision, Simple Precision and Trueness (CP, SP, TRU)

The statistical values 'within run CV%' and 'Total CV%' are now included in the overview screen summary report and in the
printed report summary for Complex Precision experiments.

A new option has also been added to Preferences under the Report tab. When the 'Sort SP, CP and Trueness Summary Report
Page by Sample' option is checked, the Summary Pages of the Reports for SP and CP are sorted in the order Instrument,
Sample, Analyte rather than in the default order Instrument, Analyte, Sample. In Trueness reports, Sample and Analyte are
called Level and Measurand. (EEC1117)

Histogram and Descriptive Statistics (HIS)

EP Evaluator prevents HIS Percentile Cutoff values below 1.0 or greater than 99.9 in the Parameters screen. (EEC1083)

Hematology Method Comparison (HMC) options

A new option has been added to Preferences under the Report tab. When the "Suppress % Bias in HMC Reports" check box is
checked, the % Bias will not be included at the bottom of the Method Comparison Report page. (EEC1116)

A 12-character limit for specimen IDs is enforced in the data entry grid on the Experiment Details screen for HMC. (EEC1096)
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R-squared included (LIN, TRU, AMC, EP9, 2IC, HMC, LOQ, INR-MC, FS, IF, STB)

A new option, Display R-squared (RSQ) in addition to R, has been added to the Preferences Reports tab. If this box is checked,
R-squared, a statistical measure of how close the data are to the fitted regression line, is calculated, included in the statistics,
and reported alongside R for the statistical modules listed above. FDA guidance documents include R-squared in the list of
recommended statistics to calculate from linear regression experiments. (EEC1115)

Open Project search

Users with large numbers of projects can now search for them more rapidly using a filter field at the top of the Open Project
tab in the File menu. The user enters any part of the project name and the project list will be filtered down to those containing
the relevant text, until the required project is displayed. (EEC1041)

Update Wizard Enhancements

The Update Wizard allows users to bring experiment data forward from previous versions of EE. Once the location of the files
is chosen, the files will be listed in a column and the user can choose which projects to import to the new version. The user
clicks the check box beside the projects to be brought forward. Projects can be listed alphabetically or in reverse chronological
order based on the last time the project was opened. (EEC766)

Project Repair/Restructure on opening

EE now automatically restructures an existing project when it is opened in an updated version of EE. If a project needs to be
revised or repaired then its database structure and field contents are updated as the project file is opened. Once updated for a
particular EE release, they will not need to be repaired again. (EEC1047)

Known issues corrected in release 11.3

Opening EP Evaluator

Registry access error warning messages are no longer displayed when a non-Admin user runs EE. (EEC1121)

The Network version of EE would intermittently crash when users would launch EE from a client system. The software was
corrected to prevent EE from crashing. (EEC1252)

Tutorial

The EP Evaluator tutorial, which is accessible from the Module Overview Screen, has been updated. (EEC287)

Rounding of numerical values (CP, LOQ, STB)

A numerical rounding anomaly evident in reports and due to rounding methodology was resolved for the statistical modules
listed above. (EEC1152)
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Simple Precision (SP)

In the SP statistical module, the RRE Wizard no longer crashes during Create Experiment from Keyboard, when only one
Level/SpecID is entered. (EEC1146)

In SP reports, the comment field is now visible again. (EEC1138)

File Manager Repair

Errors which occur during Full Repair All and Quick Repair All in the File Manager are now reported with an informative
message. (EEC1141)

Linearity and Calibration Verification (LIN)

Linearity experiments which evaluate Reportable Range will no longer report pass for Reportable Range where the lowest or
highest kit concentration levels have no specimens present in the experiment. This will be reported as a Reportable Range fail-
ure. (EEC1130)

Alternative Method Comparison (AMC)

Issue relating to the % bias calculation and Bland Altman bias in the Alternative Method Comparison statistical module has
been fixed. The issue was most noticeable in experiments where the X and Y result values were significantly different for each
specimen. (EEC1125)

Glucose POC Instrument Evaluation (POC), INR Method Comparison (INR-MC), CLSI EP10 Preliminary Evalu-
ation (EP10)

Fixed issue of data entry grids in the Experiment Details screen not having enough space. The results grids in POC Glucose
and INR-MC no longer scroll when entering results data. The EP10 results grid now takes up half of the available horizontal
screen space. (EEC671)

The Experiment Details screen for POC has been widened to ensure the 95th percentile display is not truncated. (EEC1135)

2-Instrument Comparison (2IC)

Corrected typo in the 2IC Report Interpretation Guide. (EEC1037)

CLSI EP9 (EP9)

In EP9, performing a ReCalc All now correctly respects the values for Remove Outliers in each experiment. In prior releases of
EE, all experiments were evaluated using an arbitrary value of Remove Outliers, for all experiments, when a ReCalc All was
performed. (EEC1151)

Hematology Method Comparison (HMC) Policies

Pasting invalid Regr? values for Instrument Parameters in HMC Policies now produces a warning message rather than an
exception. (EEC1071)
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Composite Reports

In previous versions, Composite Reports which were renamed with titles that contain invalid characters failed to generate
properly. Also in previous versions, reports which were given new names which did not include the .PDF extension also
failed to generate properly. In this latest version of EP Evaluator, report names are checked automatically for invalid char-
acters and the .PDF extension is added if it is not already included. (EEC1090)

Linearity EP6 statistical module (LIN EP6)

Previous versions could not properly calculate a pooled standard deviation and variance if all sample replicates were exactly
the same value for every level. Such experiments now show the Bartlett's Probabilities as 1.000 for both SD and CV, as they
should. (EEC1048)

Stability (STB)

Updated STB to enforce requirement that experiments with non-positive lower acceptability limits cannot be designed to use
first order kinetics. (EEC1128)

In prior EE releases, when creating a new experiment in STB from Policies when there are no existing STB experiments, and
then canceling the experiment by clicking cancel from the Parameters screen, artifacts of the canceled experiment appeared in
the Experiment Details screen after exiting and reentering the STB statistical module. In Release 11.3, the canceled experiment
no longer appears in the Experiment Details screen. (EEC1144)

RRE Wizard

In the second screen of the Rapid Results Entry Wizard, where the instrument is defined, it is possible to set the Specimen ID
length and format. However, if the user clicks next and then later clicks back to change the Spec ID length, this change will
not register. The user is now alerted to this restriction in advance, with a warning message beside the Force Spec ID Length
check box. (EEC1045)

The default value for the Date field in the final tab of the RRE Wizard no longer deviates from the current date if the user edits
a date in a Reagent, Calibrator, or Control in previous tabs of the RRE Wizard. (EEC1192)

Project Inventory

Project Inventory now shows all of the Geometric Mean and VRI (INR-GEO) experiments. (EEC1093)

Release 11.2 (April 2015)

NOTE: Data in the Example Policies project were changed in Release EE11.2 in order to reflect the changes that were made in
Policies for Simple Precision (SP) and Carryover (CO). If you use Example Policies, you may wish to perform a Restore from
the File Manager. You should only do this if you have not modified Example Policies, since a Restore will overwrite any
changes that you may have made. (EEC1026 and EEC740)
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Alternate Method Comparison (AMC)

AMC Specimen IDs of 12 digits are now fully visible in the reports. (EEC1011)

Carryover (CO)

Added two new Parameters in CO to support user selection of new calculations for Error Limit. Policies for CO have changed
to support these new fields. For further information, refer to the Carryover Help. (EEC1026)

Complex Precision (CP)

Fixed display of Allowable Total Error (TEa) in CP. (EEC1024)

EP9

Accidentally pasting with comma-delimited data (instead of tab-delimited data) in EP9 now causes an error message to pop
up rather than a program fault. (EEC583)

EP Evaluator (EE) – Entire Product

The Professional version of EE now allows the EE administrator to control which statistical modules are enabled and which
are not. This can be useful when a customer has only validated a sub-set of the statistical modules that are provided with EE.
(EEC786)

EE no longer crashes when no default printer is defined on Windows. (EEC889)

Establish Reference Interval (ERI)

Users can now paste data into the ERI/ROC results data grid, replacing all of the data for the current study. Judicious use of
Copy and Excel allows the user to add rows to the data for the current study. (EEC359)

Histogram and Descriptive Stats

Histogram now accepts one decimal digit in the Percentile Cutoff field. (EEC1008)

Histogram now correctly calculates the Cutoff value. (EEC1086)

Hematology Method Comparison (HMC)

EE can now automatically generate Specimen IDs during RRE – Create Experiments from Keyboard for HMC Studies.
(EEC644)

Policies for HMC now use a Yes/No drop-down box for the Regr? field. (EEC981)

The Regr? field can now be edited in HMC experiments in Setup>Edit. (EEC982)
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Incident Tracking (ITRAK)

The Like function can no longer be used with dates in Incident Tracking filters; dates can be compared using other functions.
(EEC925)

Installation

The Help and How To Order buttons now work correctly during initial entry of an Unlock Code. (EEC1033)

Linearity and Calibration (LIN)

Added a Preference to allow suppression of sentences such as "Linearity was not evaluated" in Linearity reports. (EEC984)

Linearity experiments which compute Precision now require at least one specimen with 10 or more replicates, rather than one
specimen with exactly 10 replicates. (EEC1032)

Limit of Blank (LOB)

LOB experiments with no specified manufacturer’s claim now appear with a black dot status icon in the Overview screen.
(EEC1027)

Method Comparison (MC)

EE now prevents and ignores blank Specimen IDs in all of theMC StatMods. (EEC1029)

Report Options for AMC, QMC, EP9, 2IC, POC, andMIC were changed so that the Result Sorting Options offered are now
the same across all MC statistical modules. (EEC912)

ODA users processingMC data can now take advantage of a new button on the final ODA screen, which only selects spe-
cimens that have data for every instrument present. This avoids sending specimens with partial data into an MC experiment.
(EEC771)

Experiments in AMC, EP9, and HMC with result values that are all identical no longer produce erratic slope and intercept cal-
culations. (EEC894)

Rapid Results Entry (RRE)

Specimen List in ODA can now hold up to 125 Specimen IDs. (EEC769)

Units are no longer visible in the RREWizard data grid for QMC, nor in the Paste Into Overview (PasteParmsInSS) spread-
sheet in the Resources folder. (EEC891)

Removed three unused rows concerning Controls from the HIS tab of the PasteParmsInSS spreadsheet in the Resources folder.
(EEC1007)

Removed unused Parameters from Panels for the Manual Method in the HMC Example Project. (EEC1012)

The width of Analyte column in RRE>Define Policies>Analyte Settings has been increased so analyte names are fully visible.
(EEC848)
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Invalid QMC Paste data ("P" for Positive, rather than "Y" for Yes) no longer causes run-time errors, and all incoming data are
now processed. Error messages are displayed for unexpected input values. (EEC897)

A user may open or create an RRE data grid from the Details screen of a StatMod, but they cannot Send those data to the
StatMod. If they attempt to do so, they will receive a pop-up error message. RRE Grid data can only be sent from the Overview
screen. (EEC998)

Stability now supports the following RRE functions: Paste Into Overview; Paste With Policies, List; Paste With Policies, Table;
Instrument Data Capture, and Keyboard Data Entry. (EEC528)

A clarifying statement was added to the Panels page in the RRE Wizard for HMC. (EEC645)

Reports

Analyte Units containing strings of the form "10^3" now appear correctly in reports for TRU, 2IC, IF, and AON. Previously,
"10^3" appeared as "10". (EEC1013)

Changed the way that TEa is displayed in the following StatMods: 2IC, AMC, CP, EP10, EP6, EP9, INR-MC, LIN, MIC, SP,
and TRU. The new format is clearer in some special cases. (EEC1019)

Experiments with invalid Parameter values no longer appear in the hierarchy on the left side of the Print Preview screen.
(EEC1039)

Experiments for Analytes with names that start with a hyphen will now appear correctly in reports. (EEC948)

Resources Folder

Added a menu entry to open the Resources Folder from the bottom of the Tools menu. (EEC1020)

Simple Precision (SP)

Removed irrelevant footnote from report. (EEC575)

Empty values (like "Target Mean: --") can now be suppressed via a new Preference on the Reports tab. (EEC1003)

SP experiments now support one additional Precision Verification Mode, where the user enters either a Conc, a Pct, or both.
Policies for SP now support 3 Levels, each of which contains a level name, target SD, and other fields depending on the Pre-
cision Verification Mode. Policies for SP have changed to support these new fields; old SP Policy data will have to be revised
manually. For more information, please refer to the SP Help. (EEC740)

When calculating Target CV in SP, dividing is now done by the Observed Mean rather than by the Target Mean. (EEC1050)

Simple Inventory System (SIS)

Added extended cost (quantity x item unit price) to the Shopping List. This required adding item unit price to the Items data-
base and data entry grid. (EEC8)

SIS Lot Number fields are now 16 characters long. (EEC660)
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SIS shopping list printouts will display the short name if the long name is empty (rather than displaying the empty long
name). (EEC1035)

The SIS Example Database was updated so that materials have expiration dates in the future. (EEC887)

Stability (STB)

STB experiments now correctly sort results by the time value. (EEC1113)

Statistical Module Overview Screen

Columns in the Overview data grid can no longer be moved and resized. (EEC666)

*Unclassified

Project Merge and the Update Wizard now correctly copy individual HMC experiments from an older release of EE to the cur-
rent release when the current release already contains HMC data. Study name collisions are managed by renaming new stud-
ies to look like "Study (1)" or "Study (2)". Progress messages are displayed during and after the process. (EEC943)

When a path is found in an Activity Log, a new button is made available to allow the user to open that path to inspect files
that are in that folder. (EEC986)

EE Help files are now provided in HTML5 format. (EEC1022)

Users can now register both Unlock Codes and Web Access Codes (WACs) with a single button. This eliminates a user need-
ing to know which type of code they have. (EEC1028)

Zipper now warns users if they attempt to include an empty Master Project. It also optionally opens the destination folder so
that the Zipper user can verify that the created files are correct. (EEC1038)

Update old data

ProMigrate is used to copy Security information (user names, accounts, and passwords) from older major releases of EE to the
current release of EE. ProMigrate is now working properly. (EEC924)

Release 11.1 (March 2014)

2-Instrument Comparison (2IC)

The yellow highlight in the Allowable Total Error (TEa) section now appears correctly when 2IC Parameters are incomplete.
(EEC953)

Data entered can now be viewed either in SpecID order or in the order in which the data was originally entered. (EEC739)

Alternate Method Comparison (AMC)

The AMC report has been reformatted to correctly display materials (reagents, controls, and calibrators) with maximal field
widths. (EEC844)
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Data entered can now be viewed either in SpecID order or in the order in which the data was originally entered. (EEC739)

Competency Assessment (CAT)

CAT (Competency Assessment) no longer produces an error message stating "No network seats are available". (EEC880)

Data Acquisition (ODBC)

Users are now prevented from initiating ODBC Data Acquisition while using any of the Laboratory Management Modules
(Simple Inventory, Incident Tracking, or Competency Assessment). (EEC31)

EE - Entire Project

The Zipper-generated extraction EXE now displays user-entered Dialog Title correctly. (EEC947)

The Activity Log is no longer hidden after the Save function is used. (EEC968)

Project Inventory now shows the correct total number of statistical modules with experiments. (EEC944)

Help is now accessible from the Subscription screen just prior to initially entering the unlock code. (EEC914)

A new Preference has been added that allows the user to disable the feature notifying the user when a new Update is avail-
able. (EEC883)

Users may now search for a particular material when entering and editing material information (using RRE > Lot Numbers).
(EEC878)

The Equivalency Test Code feature (inside RRE > Define Policies > Interface > Combine/Discard) now correctly handles incom-
ing analyte names up to 24 characters. (EEC867)

Each time EE starts, it will verify that it has the correct permissions for writing files and writing to the registry. (EEC831)

The amount of time remaining in the trial period is now displayed consistently on the Notice screen when running an Evalu-
ation Copy of EP Evaluator. (EEC811)

Temporary files are deleted after performing RRE. (EEC745)

The EE application can now be resized and positioned to suit the user. The Print Preview form will continue to appear full
screen. (EEC663)

EE now accepts Import/Export and other RRE .csv files that have been edited using Microsoft Excel. (EEC896)

EP6 Linearity

The user is now able to specify which kit to use in the RRE Wizard. (EEC421)

EP9

Data entered can now be viewed either in SpecID order or in the order in which the data was originally entered. (EEC739)
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EP10  Preliminary Evaluation

The description of the X flag on the report changed from “t is significant (p<0.01) if t>4.6 or t<-4.6” to “X: ABS(t) exceeds 4.6
(probability <0.01)--review for possible problems”. (EEC724)

Establishing Reference Intervals (ERI)

RRE > Create Experiment from Keyboard now creates the correct specimens when the user asks EE to automatically generate
the SpecIDs. (EEC951)

RRE into ERI/ROC no longer enters extraneous values into value lists for variables such as Sex. (EEC902)

ERI/ROC experiments created using RRE will now acquire more parameters (including date) from the RRE Wizard. (EEC749)

Factor Sensitivity (FS)

Factor Sensitivity now supports logarithmic curve fit. (EEC977)

In Factor Sensitivity, if a user copies the Experiment Detail data, edits it, and then pastes back into the screen, the Actual Dilu-
tions column is correctly ignored as long as a header row identifies the column. (EEC974)

In Factor Sensitivity, Edit > Paste with Policies > List now honors decimals found in the dilution portion of the specimen ID.
(EEC975)

The maximum dilution in Factor Sensitivity is 100% rather than 99%. (EEC978)

Theoretical Dilutions are now sorted numerically upon Import into a Factor Sensitivity experiment. (EEC985)

Factor Sensitivity will no longer create an experiment with empty key fields when the user clicks Cancel from the screen after
creating an experiment using Experiment > New. (EEC987)

A new, more informative error message is displayed when a user enters the same dilution twice from the Factor Sensitivity
Parameters screen. (EEC988)

Means and Actual Dilutions are now associated with the correct Theoretical Dilutions and replicates in Reports. (EEC980)

Experiment > New no longer prevents entry of key values that are close, but not identical, to values already present in the Pro-
ject. For example, if "Factor XII" is already present and you attempted to change the Factor to "Factor XI" you were forced to
accept "Factor XII". You can now enter your desired value. (EEC957)

Corrected the error that occurs when the user sets the Upper Limit of the Normal Range equal to the highest result value.
(EEC933)

The PasteParmsInSS spreadsheet in the Resources folder now has additional rows on the FS tab for the Analyst, Date, and
AcceptEmpty. (EEC926)

Corrected a bug that displayed the currently selected points in the graph in a different color on the Factor Sensitivity report.
(EEC921)
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Additional information on the source name (whether the assay is PT or aPTT, for example) was added to the drop-down in
Experiment > New from Policies. (EEC886)

Manually edited FS dilutions are now correctly creating the appropriate factor specific SpecIDs. Pasting into the FS Experiment
Detail screen with fewer than the maximum number of replicate columns (4) now works correctly. (EEC882)

Removed the F8 button, so users can no longer edit the SpecID and Theoretical Dilutions in the Experiment Detail data grid.
(EEC847)

Added a column to reveal the computed Actual Dilutions in the Experiment Detail screen. (EEC847)

Added Regression Limits to Parameters. (EEC847)

The RREWizard now passes the user-entered date into the newly created FS experiments. (EEC747)

The number of decimal digits in the computed Actual Dilutions is now the same as the maximum number of decimal digits in
the Theoretical Dilutions. (EEC942)*

Removed confidence intervals for the graph and the calculated sensitivity. (EEC847)*

Factor Sensitivity now allows the user to manually select regression polynomials of degree 1, 2, or 3. (EEC847)*

Factor Sensitivity now allows the user to manually select logarithmic curve fit. (EEC977)*

All of the replicates are now used for the regression, rather than just the means for each specimen. (EEC847)*

The regression degree, regression polynomial, and SEE can be seen on both the Experiment Detail screen and the report.
(EEC847)*

The R-squared value is now displayed on the Factor Sensitivity Experiment Detail screen and in the FS reports. (EEC976)*

*See the Factor Sensitivity topics in EP Evaluator Help for more detail regarding these changes.

File Manager

When running in CLIA or COFRAC licensing, the File Manager Rename and Copy buttons are disabled. (EEC770)

Hematology Method Comparison (HMC)

An error message now appears if the user attempts to exclude an HMC parameter that is used to compute another HMC para-
meter. (EEC760)

HMC scatter plots now show false negatives and false positives in the correct colors. (EEC730)

Incident Tracking

The Edit Details button on the Incident Tracking-Browse screen now conforms to the Edit Permission setting. (EEC913)
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Linearity and Calibration Verification (LIN)

In Linearity experiments that evaluate Precision, an explanatory message appears if the required number of replicates (10) is
not present for at least one specimen. Experiments with insufficient Precision replicates are also categorized as having insuf-
ficient data in the Overview screen, and the reports for such experiments now contain the PRELIMINARY watermark.
(EEC789)

A new optional Regression Summary page has been added to Linearity reports. The visibility of this new page is controlled
with a new Preference. (EEC685)

Localization/Translation

The Translator Help now works when invoked. (EEC899)

Multiple Instrument Comparison (MIC)

Run time errors no longer appear in MIC experiments with insufficient Parameter data (including an insufficient number of
instruments). (EEC790)

Computed statistics are now displayed on theMIC report even if the target instrument result values are zero. (EEC741)

Glucose POC Instrument Evaluation

Glucose POC now displays an informative message when required parameters are missing from that screen. (EEC834)

Data entered can now be viewed either in SpecID order or in the order in which the data was originally entered. (EEC739)

Policies

Error messages are displayed when truncations occur while pasting data into the Policy forms. (EEC858)

Project Management

Added the Merge Project command to the File menu, so the user can copy experiments from a selected project into the cur-
rently open project. Merge Project does not copy HMC experiments. (EEC335)

Quantitative Method Comparison (QMC)

Paste into Policy screens now accept "Y" or "Yes" and "N" or "No" for Boolean fields. (EEC781)

QMC users can now control the visibility of three statistics (Agreement, McNemar's Test, and Cohen's Kappa) in the QMC
reports. The defaults for these statistics are established in Modules and Options under Policies. They can also be controlled in
the Parameters screen for each QMC experiment. (EEC547)

Data entered can now be viewed either in SpecID order or in the order in which the data was originally entered. (EEC739)
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RRE

The RRE Wizard will now go to the correct page when the user clicks the Previous button. In previous versions, clicking Pre-
vious when trying to go back to the second screen from the third screen would take you back two screens. (EEC734)

When selecting materials (reagents, calibrators, and controls), the user can now sort by Lot Number, Source, Expiration Date,
and Comment. (EEC733)

Sensitivity - Limit of Quantitation (LOQ)

RRE data entry from Keyboard in LOQ now pre-populates the results area with the appropriate specimen names from the
selected kit. (EEC810)

Fixed a bug that prevented the Experiment Detail screen from opening when defining a New experiment from Policies.
(EEC744)

Stability

Stability experiments can now be transferred from older releases of EE by using the Update Wizard. (EEC881)

Trueness

Corrected a bug that displayed the currently selected points in the graph in a different color on the Trueness report. (EEC921)

The Trueness StatMod was updated to calculate Sigma for experiments using EQC mode, using Budget for the Analytical Goal
Mode, and supplying Lab SD values. (EEC829)

Experiment > New from Policies no longer reports "Does not contain a valid Calculation Mode" for valid experiments.
(EEC901)

RRE for Trueness now performs correctly when the user selects Replace All. Previously, Replace All did not replace all of the
experiments. (EEC879)

RRE for Trueness will now delete temporary CSV files when finished processing an XLS file. (EEC869)

Level names used with RRE for Trueness are now case insensitive. (EEC868)

RRE for Trueness updated so if the user makes a change in RRE> Create Experiment > Setup, the change is noted. If the user
tries to close Setup without saving, a warning appears that asks if he/she is sure they want to abandon the changes. (EEC803)

After performing a Save As in RRE > Create Experiment > Setup, the new Setup configuration is automatically selected upon
exit from Setup. (EEC799)

A Reset button has been added to RRE > Create Experiment > Setup to unmap all of the fields in a single operation. (EEC795)

Tutorial Files

A bug was fixed that prevented Tutorial files from being accessed if the Language in Preferences was set to "None". (EEC738)
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Release 11.0 (October 2013)

New Statistical Module: Trueness

The purpose of the EP Evaluator Trueness Module is to provide a mechanism for clinical laboratories to assess the char-
acteristics of Trueness, Accuracy, and Uncertainty for the methods used in their settings. This statistical module is intended to
satisfy the Trueness, Accuracy, and Uncertainty requirements for Comité Français d Accréditation (COFRAC) certification in
France. (EEC501)

Rapid Results Entry of Trueness data screen includes fields for the analyst name and the experiment date. (EEC835)

EP Evaluator - Entire Product

Three Preferences (Max Decimal Places on the Other tab, Minimum R for MDPs on the Calculations tab, and Always Show
Printer Selection Dialog on the Reports tab) are now properly set from the Prefs.INI file. (EEC763)

The End User License Agreement (EULA) has been revised. (EEC761)

Revised spreadsheet data in the EE11 Resources folder to reflect the modifications to Rapid Results Entry in the Complex Pre-
cision, Limit of Quantitation, and EP10 statistical modules. (EEC753)

Users can now save the contents of an Activity Log. (EEC742)

License unlock codes now contain additional customer information. (EEC731)

Preferences can now be saved to a file and are automatically sent when a bug report is made. (EEC711)

Key field names (Analyte, X Method, Y Method) are now displayed correctly for Method Comparison statistical modules
when deleting groups of experiments. (EEC701)

The Upgrade Wizard now reports when it fails to bring experiments forward because they already exist in the target database.
(EEC693)

A COFRAC license type was added to meet the needs of European users. (EEC725). This license includes
l Simple Precision
l Alternate Method Comparison
l 2 Instrument Comparison
l Multiple Instrument Comparison
l Establish Reference Interval
l Verify Reference Interval
l Carryover
l Stability
l Trueness

Complex Precision (CP, EP5)

The PrelimSDSrc field in Complex Precision policies (Modules and Options screen) was using the PrelimSDCount value even
if the PrelimSDSrc field was not set to Calc. This has been fixed. (EEC752)
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Rapid Results Entry for Complex Precision, Limit of Quantitation, and EP10 has been extensively re-worked. The required data
formats for Paste With Policies List, Paste With Policies Table, and Paste into Module Overview has changed for these three
statistical modules. In general, Rapid Results Entry is now able to handle incorrectly formatted data more gracefully, times are
now required in the data for Limit of Quantitation and EP10, incorrect reps and runs are now flagged and excluded, and more
warning messages are provided in the activity log to help users detect data problems immediately. For Limit of Quantitation
specifically, times may no longer be entered as free text ("morning") but rather must be legal times ("1:00 AM").

When the Rapid Results Entry Wizard counts the number of experiments, that count is now more accurate, and often smaller.
As a consequence, Rapid Results Entry data runs can be viewed in the grid more often if the user wishes.

Please consult the Paste spreadsheets in the Resources folder for more details about Rapid Results Entry in Complex Precision,
Limit of Quantitation, and EP10.

EP9 Method Comparison (EP9, MC)

All of the tabs on the lower right on the EP9 details screen can now be seen when the option to display Bland Altman plots is
chosen in Preferences. (EEC717)

Factor Sensitivity (FS)

The Factor Sensitivity reagent experiment field is now properly/automatically formatted. (EEC603)

File Manager (Backup/Restore)

While users can still abort the database repair that is performed automatically when a new release of EE is installed, that
repair will be repeated the next time EE starts until the user allows the repair to finish completely. This is to ensure that all of
the database files are correctly formatted for the current release.

Each time a project is repaired, it is now flagged internally with the release number. If a repair is not necessary, it is avoided
when a project is restored from the File Manager. (EEC643)

Hematology Method Comparison (HMC)

In Hematology Method Comparison, the Show Positive Specimens filter now correctly shows only positive specimens.
(EEC703)

Incident Tracking LMM (ITrack)

Incident Tracking has three new permissions to allow control over who can view reports. (EEC700)

Investigator Only fields are now handled correctly in the Other Criteria filter dropdown list.

Print preview in Incident Tracking no longer reveals the last incident in the list during incident entry. (EEC697)

Incident Tracking no longer displays a strange message when F1 is pressed from within the user administration form, and the
correct Help now is displayed. (EEC591)
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Linearity and Calibration Verification (Lin)

The statistics grid and the recovery graph are now visible in the reports in circumstances where they were absent. Note that as
a maximum of 4 graphs are visible in the reports, however, it could occur that one of the graphs is intentionally missing.
(EEC735)

ODBC Data Acquisition

EP Evaluator, as a 32-bit application, uses 32-bit ODBC DSNs. When running EE on 64-bit versions of Windows, it is possible
to create 64-bit DSNs that cannot be seen by or used by the ODBC Data Acquisition facility (ODA). A new button in ODA
allows the user to open the 32-bit ODBC Manager so that they can manage 32-bit ODBC connections more easily on 64-bit
Windows systems. EE now can use either System or User DSNs. (EEC765)

ODBC queries have been optimized to perform well with large databases. (EEC758)

ODBC_Data_Acq no longer requires Write access to the Registry. (EEC754)

EE can now acquire data from both Instrument Manager and Laboratory Production Manager using ODBC and will be sup-
porting additional data sources in the future. (EEC718)

Timeouts occurring within ODBC are now reported with a more informative message. (EEC705)

ODA translates the comma character into the pipe character to ensure multiple error flags are evaluated individually.
(EEC835)
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